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Welcome...
Welcome to the user's guide for the desk phones Aastra 6863i and Aastra 6865i for 
Aastra 400 communication systems.

This user's guide will assist you with the use of your phone and introduce you step by 
step to the functions and configuration. If you require further technical support or 
information on other Aastra products, please refer to our webpages www.aastra.ch 
and www.aastra.com or our Aastra DocFinder.

This user's guide is relevant only for Aastra SIP phones connected to a Aastra 400 com-
munication system. Other user’s guides are available for operation on other commu-
nication systems or for direct operation via a SIP provider. Consult your system admin-
istrator if you are unsure whether you have the correct user’s guide for your require-
ments.

Notes:
• Not all listed functions are available by default. Contact your system administrator 

to learn more about the available features and services in the Aastra 400 commu-
nication system.

• Your system administrator has the option to individually set some of the phone's 
features. In this case your default values will differ from the default values 
described in this user's guide.

• Some functions are offered both from the Aastra 400 communication system and 
locally from your Aastra SIP phone. Since the Aastra 400 communication system 
does not completely support the local functions we recommend making your sys-
tem administrator do the configuration or using the Aastra Self Service Portal (see 
chapter "Aastra Self Service Portal", page 7).
2 Aastra 6863i / Aastra 6865i
eud-1629/1.1 – R3.2 – 10.2014

http://www.aastra.ch
http://www.aastra.com
http://www.aastra.com/docfinder


 Welcome...
Safety information
Failure to observe this information can be hazardous and infringe existing laws.

Connections
Always plug the phone cable connectors into the appropriate sockets. Do not modify 
the connections in any way.

Power supply
Your phone can be supplied with power in various ways. Pay attention to the informa-
tion given by the system administrator. 

Note:
The device will be inoperable when mains power of the communication system fails.

Metal objects
Telephone receivers produce magnetic fields that can attract small metallic objects such 
as pins and staples. To avoid injury, do not place the handset where such objects can be 
picked up.

Maintenance
Make sure all installation and repair work is carried out by a specially qualified techni-
cian.
Always use a soft, moistened, or antistatic cloth to clean your device. Do not use chem-
icals or other chemical products.

Cost control and Data protection
You should protect your phone with a PIN so that no-one can make phone calls at your 
expense. A code will also protect your personal settings.

Ambient conditions
Do not operate the device outside the temperature range of +5 °C to approx. +40 °C. 
Avoid direct sunlight and other sources of heat. Protect your device against the wet, 
excessive dust, corrosive liquids and steam.
Do not expose your device to electromagnetic fields (electric motors, household appli-
ances). The speech quality could be affected.

Disposal
Be sure to dispose of your device, batteries and its packaging in an environmentally 
compatible way. Electrical equipment does not belong in domestic waste. Deposit it at 
a return centre.

Accessories
Use original accessories or specifically approved accessories only. The use of other 
accessories may decrease performance or pose a risk to your health or safety.
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Welcome... 
Document information

Communication system and software versions

Some custom features are not supported on all communication systems or by all soft-
ware versions. These sections are highlighted with a letter in square brackets. The fol-
lowing overview contains information on which software versions the affected cus-
tom features are supported on. Contact your system administrator for more informa-
tion.

Document designation

• Document number: eud-1629
• Document version: 1.1
• Based on communication server software version: R3.2
• Valid as of communication server software version: R3.1
• Copyright © 10.2014 Aastra Technologies Limited
• In PDF Viewer, click on this link to download the latest version of this document:
• https://pbxweb.aastra.com/doc_finder/DocFinder/eud-1629_en.pdf?get&DNR=eud-1629
Para inkl. Text notwendig, damit Link funktioniert! ==> muss nach letztem Mal EDD auf weiss gesetzt werden!!!

R3.2

[a] x

[b]

[c]

[d]
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Information as to the Aastra 400 com-
munication system

One number user concept

Your system administrator can set up several phones for you that hold all the same 
phone number (one number user concept). You have only one name and phone num-
ber with which to identify yourself to your call partners, regardless of which of the 
phone you make your calls. The advantage is that you can always be reached under 
the same phone number, regardless of where you happen to be.

With personal call routing you can define where incoming calls shall be routed to (see 
chapter "Activating personal call routing", page 39).

You can determine the phone on which a call is acoustically signalled, with Ring Alone 
(see chapter "Activating ring alone", page 40). Your system administrator can set 
whether or not you are busy for further incoming calls (Busy if busy). You are still able 
to make further outgoing calls with the other terminals. Call lists and contacts stored 
on the Aastra 400 communication system are available on all your phones and are 
automatically synchronised. An announcement will be indicated on all phones which 
support announcements.

Aastra Self Service Portal

The Aastra Self Service Portal is a web-based application for phones on a  Aastra 400 
communication system. The Aastra Self Service Portal helps you configure and adapt 
your personal phone settings (i.e. key configuration, labels for configurable keys, dis-
play language, etc.) directly and autonomously on your PC.

As soon as you receive an user account for the Aastra Self Service Portal from your 
assistant manager and after you have logged in, you are taken to the home page with 
the overview of all your phones. Refer to the Aastra Self Service Portal online help for 
further information on a specific topic.

Contact your system administrator to access to the Aastra Self Service Portal.



Keys, display and menu guidance
The sections below provide an overview and usage on which keys and sockets 
are available on your phone.

Key designations and sockets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Display symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Operating your phone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Using expansion key modules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Using labels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
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 Keys, display and menu guidance
Key designations and sockets
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Aastra 6863i / Aastra 6865i 9
eud-1629/1.1 – R3.2 – 10.2014



Keys, display and menu guidance 
Aastra 6865i
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 Keys, display and menu guidance
No. Key Description and use

1 Handset

2 Labels Labels for configurable keys

3 Message LED Colour and status signal a specific event.

4 Function keys P1 to P3 
(Aastra 6863i)

Free configurable keys. Preconfigured as:
• System menu
• Redial list
• Call transfer

Function keys P1 to P8 
with LED (Aastra 6865i)

8 free configurable keys (some preconfigured). An LED is 
located next to each function key signalling the functional 
state. The keys have a dual assignment.

5 Display Monochrome screen

6 Navigation key with 
selection key

• Navigating through the menu
• Switch line
• Confirming menu selection

7 Deflect key
(Aastra 6865i only) Transferring a call

8 Conference key
(Aastra 6865i only) Setting up conference calls

9 Call list key
(Aastra 6865i only)

Calling up the call list menu:
• unanswered
• answered
• Redial list

10 Redial key (Aastra 6865i 
only)

Using the phone number last dialled

11 Line keys L1 to L2 with 
LED

Aastra 6863i: 2 line keys
Aastra 6865i: 2 line keys. A total of 9 lines are available.
• Seizing a line
• Answering a call
• Brokering with simultaneous configuration of multiple line 

keys

12 Loudspeaker key with 
LED (Aastra 6863i)

• Activating/deactivating open listening
• Activating/deactivating handset microphone

Loudspeaker/headset 
key with LED 
(Aastra 6865i)

• Activating/deactivating open listening
• Activating/deactivating handset microphone
• Activating/deactivating headset microphone

13 Hash key Entering # or special characters
Aastra 6863i / Aastra 6865i 11
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Keys, display and menu guidance 
14 Digit keys 1-9 Entering characters and digits

15 Asterisk key Entering * or space

16 Microphone key with 
LED

• Activating/deactivating hands-free mode
• Activating/deactivating handset microphone
• Activating/deactivating headset microphone 

(Aastra 6865i only)

17 Volume keys Adjusting volume

18 Option key Calling up a local setting menu (options list)

19 Hold key • Holding an active call
• Taking back a call from hold

20 End key • Ending a call
• Back to display in idle state
• Exiting editor without changes

21 Speaker

22 Rear (Aastra 6863i):
• 100BaseT dual connection for PC and LAN
• Connection for power supply
• Connection for headset
• Connection for Power-over-Ethernet
• Connection for wall mounting

Rear (Aastra 6865i):
• Connection for expansion key module
• Connection for power supply
• Combined four-pin module connection with DHSG headset connection1)

• GigE dual connection for PC and LAN
• Connection for headset
• Connection for Power-over-Ethernet, class 2
• Connection for wall mounting

1) Use the headset connection for headsets only. Connecting another device may cause damage to your 
phone and void your warranty.

No. Key Description and use
12 Aastra 6863i / Aastra 6865i
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 Keys, display and menu guidance
Display symbols

Operating your phone
Most keys and functions are described in the key legend. Other overviews and 
operating aids can also be found here.

Overview system menu

Access to the system menu is made using the Menu. This contains the following menu 
entries. Refer to the relevant chapters of this user’s guide for further information on 
these menu entries.

Call connection states, info

• Context-dependent softkey
• Scrolling back through the menu
• Navigate cursor
• Switching line

• Context-dependent softkey
• Goes forward one step in the menu
• Navigate cursor
• Confirming menu selection
• Switching line

• Context-dependent softkey
• Navigating through the menu
• Navigate to display in idle state

• Context-dependent softkey
• Navigating through the menu
• Confirming menu selection
• Navigating to display in idle state

Incoming call Active connection

Aastra Hi-Q™ audio technology Data/voice encryption

New voice message Activated setting

Entry System menu Entry System menu

1 Call list 5 Presence

2 Directory Lookup 6 Call routing

3 Voice mail 7 Alarm melodies

4 Forwarding 8 Information
Aastra 6863i / Aastra 6865i 13
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Keys, display and menu guidance 
Using the softkey/navigation key

Softkeys are the keys that are automatically configured with context-dependent func-
tions by the Aastra 400 communication system. The functions are displayed on screen 
and operated with the navigation key.

A menu can have several sub-menus. Press the Execute softkey (navigation key down 
or to the right) to access the sub-menu or the selection of the possible editing 
options, or to carry out the action.

Free configurable keys

Aastra 6863i: Your Aastra 6863i has three free configurable keys that are preconfig-
ured with the following functions as standard by your system administrator:

• System menu
• Redial list
• Call transfer. 

You can configure these programmable keys with another function or call number.

Aastra 6865i: Your Aastra 6865i is equipped with freely configurable keys. Popular 
functions are set up on a specific configurable key as standard by your system admin-
istrator (see chapter "Overview function key configuration (default key setting)", 
page 15). The remaining configurable keys can be configured with a specific action 
type: Call number, function, busy lamp field.

The key configuration is not made directly on the phone. Available settings for the key 
configuration:

• Aastra 400 communication system: The configuration has already been made by 
your system administrator in the communication system.

• Aastra Self Service Portal: You can use the Aastra Self Service Portal (see chapter 
"Aastra Self Service Portal", page 7) where you can configure, change or delete the 
keys however you wish.

More information on the configurable keys can be found in the chapter "Configuring 
keys", page 69.
14 Aastra 6863i / Aastra 6865i
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 Keys, display and menu guidance
Overview function key configuration (default key setting)

Aastra 6863i/Aastra 6865i phones on the Aastra 400 communication system are deliv-
ered with the following function key configuration. Please note that your system 
administrator may change this and your phone may therefore differ from this default 
configuration.

Function key Aastra 6863i Aastra 6863i if logged in as 
free seating phone

Key P1 System menu System menu

Key P2 Call list: Redial list Call list: Redial list

Key P3 Call transfer Call transfer

Function key Aastra 6865i Aastra 6865i if logged in as 
free seating phone

Key P1 System menu System menu

Key P2 Voice mail menu Free seating: Log in/out

Key P3 Request a callback Request a callback

Key P4 Empty1)

1) The key assignment is configured with an empty function.

Empty1)

Key P5 Empty1) Empty1)

Key P6 Empty1) Empty1)

Key P7 Empty1) Empty1)

Key P8 Empty1) Empty1)
Aastra 6863i / Aastra 6865i 15
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Keys, display and menu guidance 
Overview alphanumeric keyboard

The alphanumeric keyboard can be used for entering digits and the password, for 
entering text and special characters, and also for quickdial. Press the relevant key 
repeatedly until the character you want is displayed.

The alphanumeric keyboard is configured with the characters from the following 
table. Please note that the actual character selection is dependent on the selected 
language.

Entering text

Digit and letter input: In text mode, press the key repeatedly until the desired char-
acter appears in the display.

Correcting the input: Use the navigation key to the left to correct any incorrect char-
acter.

Confirming the input: An input or selection can be confirmed using the Execute soft-
key.

Exiting the editor without saving: With the Cancel softkey or the done key, you can 
cancel the input without saving or go back to the idle state in the menu.

1 . : ; = _ , - ’ & ( )
A B C 2 Ä Á À Â Ã Æ Å Ç А Б В Г
a b c 2 ä á à â ã æ å ç a б в г

D E F 3 É Ê Д Е Ё Ж Э
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G H I 4 Í Ï Î И Й К Л
g h i 4 ì í ï î и й к л

J K L 5 М Н О П
j k l 5 м н о п

M N O 6 Ñ Ö Ó Ò Ô Õ Ø Р С Т У
m n o 6 ñ ö ó ò ô õ ø р с т у

P Q R S 7 ß Ф Х Ц Ч
p q r s 7 ß ф х Ч ч

T U V 8 Ü Ú Ù Û Ш Щ Ъ Ы
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W X Y Z 9 Ь З Ю Я
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16 Aastra 6863i / Aastra 6865i
eud-1629/1.1 – R3.2 – 10.2014



 Keys, display and menu guidance
LED overview

Depending on the situation or status, the message LED on the phone or the LED on 
the function key/line key lights up.

Message LED State Description

Flashes fast • Incoming call
• Appointment call

Flashes slowly New voice messages

Lit Phone locked

LED on line key State Description

Does not light up Line free

Flashes fast
• Incoming call
• Appointment call

Flashes slowly
Call party on hold. Call be answered on any 
phone.

Lit Active connection

LED function key or busy 
lamp field key1)

1) Aastra 6865i only

State Description

Does not light up • Function is deactivated
• User free (busy lamp field)

Flashes fast
User is being called
(Busy lamp field)

Lit • Function is activated
• User busy (busy lamp field)
Aastra 6863i / Aastra 6865i 17
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Keys, display and menu guidance 
Using expansion key modules
The connection of expansion key modules to your phone (Aastra 6865i only) 
gives you additional, freely configurable keys.

Expansion key module Aastra M680i

You can connect up to three Aastra M680i expansion key modules next to each other 
on your phone. The Aastra M680i has the following properties:

• 16 configurable keys. Three expansion key modules would then give you an addi-
tional 48 configurable keys.

• Each key has an LED for visual signalling.
• The keys on the expansion key module support all key types that are supported by 

your phone's keys.
• The configurable keys of the expansion key module can be operated as the config-

urable keys of your phone.
• The key configuration must have been made either by your system administrator 

or by yourself in the Aastra Self Service Portal (see chapter "Aastra Self Service Por-
tal", page 7).

• Labels for key identification (see chapter "Using labels", page 20).
18 Aastra 6863i / Aastra 6865i
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 Keys, display and menu guidance
Expansion key module Aastra M685i 

You can connect a Aastra M685i expansion key module[a] to your phone. In addition, 
you can connect two Aastra M680is. The Aastra M685i has the following properties:

• Coloured touchscreen
• Three key levels of 28 configurable keys each (84 configurable key in total). One 

Aastra M685i and two Aastra M680i would then give you an additional 116 config-
urable keys.

• Each key has an LED for visual signalling.
• The keys on the expansion key module support all key types that are supported by 

your phone's keys.
• The configurable keys of the expansion key module can be operated as the config-

urable keys of your phone.
• The key configuration must have been made either by your system administrator 

or by yourself in the Aastra Self Service Portal (see chapter "Aastra Self Service Por-
tal", page 7).

• If you remove an expansion key module or if you modify the order of the con-
nected expansion key modules, the keys configuration does not change.

• The display contrast setting and the display backlight is taken from your phone.

No. Key Description

1 Function keys A1-A84
(3 key levels of 28 keys each)

Free configurable keys An LED is located 
next to each function key signalling the 
functional state

2 Function key for level 1, 2, 3 Call up the desired level.
Aastra 6863i / Aastra 6865i 19
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Keys, display and menu guidance 
Using labels

Printing and attaching the labels

Labels can be created and printed using the Aastra Self Service Portal (see chapter 
"Aastra Self Service Portal", page 7).

Aastra 6863i / Aastra 6865i:

1. Label the write-on labels via the Aastra Self Service Portal and print them (impor-
tant printing setting: "Page scaling for printing: None").

2. Cut out the labels according to the crop marks.
3. Remove the cover and insert the label into the recess.
4. Re-insert the cover into the recesses on the keypad.

Aastra M680i (Aastra 6865i only):

1. Label the write-on labels via the Aastra Self Service Portal and print them (impor-
tant printing setting: "Page scaling for printing: None").

2. Cut out the labels according to the crop marks.
3. Remove the cover and insert the label into the recess.
4. Re-insert the cover into the recesses on the keypad.
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The following sections explain the supplementary features provided by your 
phone for more efficient use.

Making calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Initiating calls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Using functions before/while in a call. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Using further functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Overview of available functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Organising absences from the desk. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Operating call lists and voice messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Organisation within the team (busy lamp field, Aastra 6865i only)  . . . . . . . . . . . . . . . . . . . . . . . . 53

Line key on a key telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Using functions with OpenCount . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Setting functions by remote control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
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Making calls
This section explains how to set your calls.

Answering, ending or rejecting a call

Answering a call: The phone rings and the message LED and line key LED flash. If the 
caller's phone number is received, it is shown on the display. If the phone number is 
stored in the private phone book or in the Aastra 400 communication system, the dis-
play also shows the corresponding name.

Open listening: With the open listening mode function, the loudspeaker is activated in 
addition to the handset so that other people in the room can listen to the call. You can 
continue with the call as usual using the handset.

Rejecting a call: As long as you have not picked up a call, you can reject a call during 
the ringing phase.

Using your phone in handsfree mode

You want other people to join the conversation or to have your hands free while making 
the call.

Answering a call with the handset:
Pick up the handset.

Answer a call with the line key
Press the line key and pick up the handset.

Open listening during a call:
Activate: Press the Loudspeaker key1).
Deactivate: Press the Loudspeaker key a second time.

1) The Loudspeaker key shown corresponds to the key on the Aastra 6865i.

End a call in open listening mode
Press the Loudspeaker key and pick up the handset.

Note:
If you merely replace the handset, the phone switches to the hands-free mode.

Ending a call:
Put the handset on-hook or press the End key.

Rejecting a call:
Press the End key during the ringing phase.
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 Phoning
The handsfree mode function activates the loudspeaker and the microphone. Make 
sure the hands-free microphone is not obstructed. The sound quality is improved if you 
set the volume of your phone to a low setting.

Muting the microphone

In the middle of a call you want to talk briefly with other persons in the room without 
your call partner hearing your conversation.

You can switch the microphone on and off during a call, regardless of whether you are 
using the handset, headset or handsfree system.

Using a headset (Aastra 6865i only)

To make a phone call with the headset.

If you answer a call in headset mode using the Loudspeaker key, the call is provided on 
the headset. Alternatively you can also answer the call by picking up the handset.

All the headset mode configuration possibilities can be found in chapter "Setting the 
audio properties", page 61. Further information can be found in the user's guide for your 
headset.

Answering/ending a call in handsfree mode:
Answer: Press the loudspeaker1) or the line key.
End: Press the End key.

1) The Loudspeaker key shown corresponds to the key on the Aastra 6865i.

Handsfree during a call:
1. Press the Loudspeaker key.

➔Open listening is activated.
2. Put the handset on-hook.

➔Handsfree is activated.

To continue the call with the handset:
Pick up the handset.
➔ The loudspeaker and hands-free microphone are now deactivated.

Ending a call:
Put the handset on-hook.

Switching the microphone on and off during a call:
Activate: Press Microphone key.
Deactivate: Press the Microphone key once again.
➔ The microphone is activated/deactivated. The LED on the Microphone key 

flashes/does not flash (Aastra 6865i only).
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Initiating calls
This section explains some convenient features provided by your phone for mak-
ing a call.

Dialling with the phone number

You want to call someone and key in that person's phone number.

With call preparation you can enter a phone number without it being dialled automati-
cally, so you have time to check the number and, if necessary, correct it. The number is 
not dialled until you go off-hook, for example by picking up the handset.

Dialling from the phone book (directory lookup)

You want to make a call by entering a name.

With directory lookup, you can search for an contact in your private phone book, system 
phone book or a connected external phone book. The response time may vary depend-
ing on the size and the number of phone books connected. The following search 
options are available:

Answering a call with the headset:
Press the key on the headset or the Loudspeaker key.

Ending a call with the headset:
Press the key on the headset or the Loudspeaker key.

<Call number> Dialling with the phone number:
Enter a phone number in call preparation.
Use the navigation key to the left to delete any incorrect character.

Pick up the handset or press the Dial softkey.

Menu Description

Quickdial With Quickdial you only need to press the digit keys for each letter once, 
even though each key is assigned several letters. An efficient algorithm pro-
vides quick search results.

Dial by name Enter the corresponding letter for dialling by name.
The surname and first name have to be separated by a space (*-key).

☛
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Tips for search input:

• Press each of the corresponding digit keys once for the first few letters of the name 
you are looking for. For each letter, the display shows the corresponding digit, for 
example a "6" for the letter "n".

• Ask your system administrator whether you should start with the surname or the first 
name.

• The search function is not affected by upper/lower case and special characters.
• More information on the phone books can be found in the chapter "Phone books 

management", page 65.

Advanced search If you select Advanced search, you can search directly in the connected exter-
nal phone books. This function is not available if no external phone book is 
connected.
The surname, first name and town each have to be separated by a space, for 
example "no s so" for Noble Stephen in Solothurn.

Menu Directory lookup:
Press the function key for Menu.

Directory Lookup
Scroll to Directory Lookup and press the navigation key to the right.

<Directory Lookup> Scroll to Quickdial, Dial by name or Advanced search and press the navigation key to 
the right.

<Name> Directory lookup with quickdial: Enter the first few letters of the name you are 
looking for using the corresponding digits.
Directory lookup with dialling by name: Enter the first few letters of the name 
you want.
Directory lookup with advanced search: Enter the first few letters of the name 
you are looking for and the town (each separated by a space).

Enter Press the Enter softkey.
➔ Names list (or List empty, if the phone is unable to find a matching user) is dis-

played.

Scroll through the list and select the user you want.

Pick up the handset.
➔ The phone number displayed is dialled.

Menu Description

☛
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Dialling from the call list

You want to call a user from one of the three call lists. You can choose from the following 
call lists:

Your phone automatically stored the person's phone number and name in a call list in 
the Aastra 400 communication system. Within the one number user concept (see chap-
ter "One number user concept", page 7) you can call back users through one of these 
call lists. The individual call lists include a maximum of 30[a] entries per list. Information 
on call lists can be found in the chapter "Editing options for the call list", page 51.

The call lists can be operated via the Call list key, the Redial key, the system menu, or a 
function key (see chapter "Configuring keys", page 69).

Call list Description

Unanswered calls List of callers who tried to reach you when you were absent.

Answered calls List of calls answered.

Redial list List of calls made.

Aastra 6863i:

Menu Call list for unanswered/answered calls:
Press the function key for Menu.

Call list
Scroll to Call list and press the navigation key to the right.

Unanswered/Answered Scroll  to Unanswered or Answered and press the navigation key to the right.
➔ The display shows a list of the last unanswered/answered calls.

Scroll through the list until the user you want is displayed.

Pick up the handset.
➔ The call number of the user is dialled.

Note:
Once the call has been successfully connected, the entry is deleted from the unan-
swered call list.

Aastra 6865i:

Call list for unanswered/answered calls:
Press the call list key.

Unanswered/Answered Scroll to Unanswered or Answered and press the navigation key to the right.
➔ The display shows a list of the last unanswered/answered calls.
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Dialling with a configurable key

You want to call someone whose phone number is stored under a configurable key.

To find out how to configure a configurable key, refer to the chapter "Configuring keys", 
page 69.

Dialling with the line key

You want to make a call via a line key.

Aastra 6863i: You can make a call via a line key. Your phone is equipped with two dedi-
cated line keys with LED (L1, L2).

Aastra 6865i: You can make a call via a line key. Your phone is equipped with two dedi-
cated line keys with LED (L1, L2). Your system administrator can set up to seven addi-
tional line keys (making a total of nine). The actual number of line keys depends on the 
system configuration. Press a fix line key directly or select a line by pressing the horizon-
tal navigation key to the right or left. The display will show the line number (L1, L2 etc.).

Scroll through the list until the user you want is displayed.

Pick up the handset.
➔ The call number of the user is dialled.

Note:
Once the call has been successfully connected, the entry is deleted from the unan-
swered call list.

Redial list:
Press the Redial key.
➔ List of the last dialled entries is displayed.

To scroll through the call numbers last dialled, press the navigation key down-
wards.

Pick up the handset.
➔ The call number of the user is dialled.

Phoning with the handset:
1. Pick up the handset.
2. Press the desired configurable key.
➔ The phone number is dialled.

Using your phone in handsfree mode:
Press the desired configurable key.
➔ The phone number is dialled.
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You can switch the line by pressing the key. The active call is automatically put on hold 
locally.

Activating another Aastra phone for making calls

You want to make a call on another Aastra phone using your personal settings, for 
example on a colleague’s phone or in a meeting room.

You can activate another Aastra phone to make an internal or external call using your 
personal settings, even if the phone is locked for external calls. You can activate the 
phone for a business or private call. Once you have activated the phone using a function 
code and your PIN, dialling by your private phone book is available. The called party's 
display shows your personal phone number and not the number of the phone from 
which you are making your call. Any call charges incurred will be charged to you.

<Call number> Dialling with the line key:
Enter the phone number.

Press a free line key.
➔ The phone number is dialled. The LED on the line key lights up.

Holding the call and switching lines:
1. Press a second, free line key or select a new line key with the horizontal naviga-

tion key.
2. Enter the phone number.
➔ The call is held on line key 1 and the call on line key 2 is active.

Note:
Press line key 1 to return again to the call party on line 1 (see also chapter "Broker-
ing between an enquiry call party and your call partner", page 32).

<Function code> Business calls:
1. Enter function code #36 for a business call.
2. Enter your internal phone number.
3. Enter your PIN.
4. Enter the internal or external phone number with the exchange access digit.

Pick up the handset.
➔ The phone number displayed is dialled.

Note:
When you hang up, dialling by name and your private phone book remain availa-
ble for a whole minute so you can make another call.

☛

☛

28 Aastra 6863i / Aastra 6865i
eud-1629/1.1 – R3.2 – 10.2014



 Phoning
Private call with PIN

You want to make a private call on your phone or on another Aastra phone.

With the aid of your PIN you can use any phone to make an external call with your own 
personal settings, even if that phone is locked for external calls. The called party's dis-
play shows your personal phone number and not the number of the phone from which 
you are making your call. Any call charges incurred will be charged to you. The call num-
ber dialled is not stored in the last-number redial list.

Using functions before/while in a call
This section explains the special features provided by your phone before you 
make a (second) call or while you are in a call.

Requesting a callback

You want to talk to a certain person. The person is busy or does not answer. You can 
make callback requests to both internal and external users. Not all providers support 
this function.

<Function code> Private calls:
1. Enter function code #46 for a private call.
2. Enter your internal phone number.
3. Enter your PIN.
4. Enter the external call number directly, without the exchange access digit.
5. Pick up the handset.
➔ The phone is now enabled; the external user is called.

Note:
The default PIN setting ‘0000’ is not accepted (for more information on the PIN, see 
chapter "Changing the PIN", page 63).

<Function code> Private call with PIN:
1. Enter function code #46 followed by your internal call number.
2. Enter your PIN.
3. Enter the external call number directly, without the exchange access digit.

Pick up the handset.
➔ The phone is now enabled. The external user is called.

Note:
The default PIN setting ‘0000’ is not accepted (for more information on the PIN, see 
chapter "Changing the PIN", page 63).

☛

☛
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If the called party is busy, you can activate an automatic callback. In this case, your 
phone will start ringing as soon as the party you are trying to reach goes on-hook. When 
you pick up the handset, the person you want to call is dialled directly. If the called party 
does not answer, you can also request a callback. The user then obtains a message indi-
cating your callback request on his display.

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

To answer the callback request

Someone has asked you to call back. The display shows Callback.

You cannot automatically answer a callback request on your phone. You can either enter 
the call number manually or you use a CTI client as for example the Aastra OfficeSuite.

Notes:
• You can activate only one callback at a time.
• An unanswered callback request will automatically be cancelled by the system 

after about half an hour.

Request a callback Activating callback:
You called someone and hear the busy tone or the ring-back tone. Press the func-
tion key for Request a callback.
➔ Depending on the communication system you hear the acknowledgement 

tone.

Put the handset on-hook.
➔ The display shows Call expected. The LED of the function key is switched on 

(Aastra 6865i only).

Request a callback Clear callback:
Press the function key for Request a callback. 
➔ Callback request is deleted.

<Call number> Answering the callback request:
Enter a phone number in call preparation.

Pick up the handset or press the Dial softkey.

Note:
You cannot delete a callback request.

☛
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Hide number

You do not want your call number to appear on the terminal display of a called party in 
the public network. The following options are available here:

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

Putting a call partner on hold

You want to briefly interrupt the active call.

You can put the call party on hold and then take them back again on the same phone.

Menu Description

Permanent The call number is never displayed.

Per call Call number should only be restricted for certain calls. This function must be 
activated before dialling the call number.

Notes:
• Your call number can only be hidden if you select an external call number.
• This feature depends on the range of services offered by your provider.

Hide number Activating/deactivating calling line identification restriction permanently:
Press the function key for Hide number.
➔ The function is activated/deactivated. The LED on the function key is switched 

on/off (Aastra 6865i only).

Hide number Activating CLIR per call:
1. Press the function key for Hide number.
2. Enter the call number and press the Enter softkey.

➔Call number is dialled and your own number is not displayed to the called 
party.

Putting the active call party on hold:
Press the Hold key.
➔ The call party is put on hold. The LED on the line key flashes.

Take back the call party on hold:
Press the Hold key or the flashing line key.
➔ The call is active again.
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Enquiry call during a call

You want to call someone else briefly without losing your current call partner. Then you 
want to resume your conversation with your original call partner.

With the Enquiry function you can call someone else in the middle of a call and put your 
original call partner on hold. You can make enquiry calls to both internal and external 
users.

Brokering between an enquiry call party and your call partner

You are talking with an enquiry call party and have your first call partner on hold. You 
want to be able to switch back and forth between the two.

In an enquiry call you can use the brokering function to switch back and forth between 
an enquiry call party and the party on hold. Brokering is possible with both internal and 
external users. You can also broker between conference parties as a group and an 
enquiry call party.

Setting up an enquiry call (you are in an active call):
Press a free line key (select using the horizontal navigation key, if necessary).

<Call number> Enter the call number and press the Dial softkey.
➔ Enquiry call party is called; first call partner is put on hold.

Note:
If the other user does not answer, you can cancel the enquiry call with the End key 
and take back the first call with the flashing line key.

Ending the enquiry call:
Press the End key.

Retrieving the first parked call party:
Press the flashing line key.

Brokering (to switch back and forth between the callers):
You are in an active call and have set up a connect to another call party with the 
Enquiry function.
Press the flashing line key.
➔ Your call partner changes. The other call party is put on hold.

Terminating the active call:
Press the End key.

Retrieving the first parked call party:
Press the flashing line key.

☛
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Making a conference call

You want to make a conference call.

Three call parties can be connected using the conference function. From the conference 
call you can initiate an enquiry call to someone else. You can broker between the parties 
of the conference and the enquiry call party. Depending on the system configuration, a 
conference call can consist of up to 6 conference participants. You can hold a confer-
ence call with internal and external users.

Aastra 6863i: This function must be stored under a function key (see chapter "Configur-
ing keys", page 69).

Transferring a call

You want to put your call partner through to someone else.

With the call transfer function you can connect your call partner with someone else. You 
can connect internal and external users with one another. You can transfer the call with 
or without prior notice:

Aastra 6863i:

Conference Setting up a conference (you are in an active call)
1. Press the function key for Conference.
2. Enter the phone number of the conference call party.
3. Press the Dial softkey.

➔The conference party answers the call.
4. Press the function key for Conference.

Leaving a conference call:
Put the handset on-hook or press the End key.
➔ The other conference parties remain in the call.

Aastra 6865i:

Setting up a conference (you are in an active call):
1. Press the Conference key
2. Enter the phone number of the conference call party.
3. Press the Dial softkey.

➔The conference party answers the call.
4. Press the Conference key

Leaving a conference call:
Put the handset on-hook or press the End key.
➔ The other conference parties remain in the call.
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Aastra 6863i: This function must be stored under a function key (see chapter "Configur-
ing keys", page 69).

Menu Description

Call transfer with prior notice You only transfer the call after you have first talked to the second call 
party yourself.

Call transfer without prior notice Without talking to the second call party, you transfer the call to them by 
hanging up the handset immediately after dialling the call number.

Aastra 6863i:

Call transfer Call transfer with prior notice (you are in an active call):
1. Press the function key for Call transfer.
2. Enter the call number of the second call partner and press the Dial softkey.

➔The second call party is called; first call partner is put on hold.
3. Wait until the person has answered the call.

➔If the other user does not answer, you can cancel the second call with the 
Cancel softkey or with the End key and take back the first call.

4. Announce the call party.
5. Put the handset on-hook.

➔Your first call partner and the other person are now connected with each 
other.

Call transfer Call transfer without prior notice (you are in an active call):
1. Press the function key for Call transfer.
2. Enter the call number of the second call partner and press the Dial softkey.

➔The second call party is called; first call partner is put on hold.
3. Wait for the first ring tone.
4. Put the handset on-hook.

➔The other party is then called directly by your first call partner.
➔Recall: If the other party does not answer, the call comes back to your phone.

Aastra 6865i:

Call transfer with prior notice (you are in an active call):
1. Press the Deflect key.
2. Enter the call number of the second call partner and press the Dial softkey.

➔The second call party is called; first call partner is put on hold.
3. Wait until the person has answered the call.

➔If the other user does not answer, you can cancel the second call with the 
Cancel softkey or with the End key and take back the first call.

4. Announce the call party.
5. Put the handset on-hook.

➔Your first call partner and the other person are now connected with each 
other.
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Take (pick up own call)

You want to transfer a call from one phone to another without interrupting the connec-
tion (for example, from a desk phone to a cordless phone).

The take function can be used to transfer calls between your phones. 
Requirement: They are within the one number user concept (see chapter "Purpose and 
function", page 72).

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

Starting announcement

You want to speak directly to an internal user or an announcement group via the loud-
speaker - where available - without expecting an answer (similar to an intercom). The 
recipient is alerted to the announcement by two short signal tones. You are immediately 
unilaterally connected via the loudspeaker.

If the internal user has secured their phone against announcements (configuration see 
chapter "Activating protection against call types", page 65), you cannot speak to them 
using an announcement. You will get the engaged tone.

The announcement function[a] must be stored under a function key (see chapter "Con-
figuring keys", page 69). You can either configure the function key directly with a desig-
nated user or input the call number manually each time.

Call transfer without prior notice (you are in an active call):
1. Press the Deflect key.
2. Enter the call number of the second call partner and press the Dial softkey.

➔The second call party is called; first call partner is put on hold.
3. Wait for the first ring tone.
4. Put the handset on-hook.

➔The other party is then called directly by your first call partner.
➔Recall: If the other party does not answer, the call comes back to your phone.

Take Picking up your own call (you are in an active call):
Press the function key for Take.
➔ After a brief moment, you are connected with the caller on another phone.

Aastra 6865i:
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Announcement to a group:

• The announcement will only be received by phones which both have authorisation 
to receive announcements and are not in use.

• As soon as a user in a group picks up the handset to answer the announcement, the 
announcement is ended for all other users in the group.

• If receipt of announcements is not authorised on any of the phones in the announce-
ment group or all the phones are in use, you will hear the busy tone.

• Group announcements are always conducted with a one-sided connection.
• The group number must be entered as two digits.

Receiving an announcement\

You will be alerted to the announcement with two short signal tones[a] and spoken to 
directly via the loudspeaker across a one-sided connection. The display shows 
Announcement from.

In order to be able to receive an announcement, your phone must be neither in use nor 
locked against announcements (configuration see chapter "Activating protection 
against call types", page 65). To answer the announcement, the following options are 
available to you:

• You can continue the announcement as a phone call by picking up the handset.
• You can stop the announcement.

Announcement to a group:

• The announcement will only be received by phones which both have authorisation 
to receive announcements and are not in use.

• As soon as a user in a group picks up the handset to answer the announcement, the 
announcement is ended for all other users in the group.

<Announcement> Start announcement to a user:
Press the function key for <announcement to a user>. Depending on the settings, 
enter the call number.
➔ The user is alerted to the announcement by two short tones on the loud-

speaker. The one-sided connection is made, you can talk.

<Announcement> Start announcement to a group:
Press the function key for <announcement to a group>. Depending on the set-
tings, enter the two digit group number.
➔ The user group is alerted to the announcement by two short tones on the loud-

speaker. The one-sided connection is made, you can talk.
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• If receipt of announcements is not authorised on any of the phones in the announce-
ment group or all the phones are in use, you will hear the busy tone.

• Group announcements are always conducted with a one-sided connection.

Recording a call

You want to record an active call with your call partner.

You can record an active conversation if you have been authorized to do so by your sys-
tem administrator. Your call party can be an internal or an external user. The recordings 
are made and backed up only as .wave files in your individual e-mail boxes. For this, you 
must configure at least one e-mail address in the Aastra 400 communication system. 
You can find a call recording overview in your e-mail box. Contact your system adminis-
trator for more information.

You can start recording calls in the following situations:

• during an active call;
• During a conference call (with maximum two participants)
• During an incoming/outgoing call
• in call preparation;
• During dialling with a busy line.

Call recording only starts when the connection is set up. Therefore, no ring-back tones 
or wait tones are recorded.

Call recording is temporarily interrupted during an enquiry and an e-mail is sent with 
the recording made up till then. Recording restarts automatically once the call connec-
tion with the enquiry call party is set up and/or once the call connection with the first 
correspondent is restored.

You will be alerted to the announcement with two short signal tones and spoken to directly via the 
loudspeaker.

Continue an announcement as a phone call:
Pick up the handset.
➔ You are on the phone with whoever started the announcement.
Note:
If the announcement was started to the group, all other recipients of the 
announcement will be excluded.

Stop announcement:
Press the End key.
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The maximum recording time for each .wave file depends on the system configuration. 
When the predefined or maximum recording time is reached, the recording stops auto-
matically, the file is sent to your e-mail address and a new recording starts at the same 
time. Contact your system administrator for more information.

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

Activating do not disturb

You do not want to receive any calls for the time being.

With the do not disturb function, you can stop calls being made to you if you are busy in 
a call or are not otherwise able to take any calls. Your incoming calls are automatically 
forwarded to a corresponding destination that has been configured by your system 
administrator.

Notes:
• Recording calls may infringe on your national data protection provisions or be 

permitted only under certain circumstances. If you intend to use this function 
notify your call party in advance.

• You cannot record a conversation involving more than two call parties (enquiry 
call, conference). The recording is automatically stopped if you park your call 
party or put him on hold.

Call recording: Start/stop Recording a call:
Press the function key Call recording: start/stop as soon as you have an incom-
ing/outgoing call or an active call.
➔ The call is recorded. The LED on the function key is switched on (Aastra 6865i only).

Call recording: Start/stop Stopping the call:
End the recording using also the Call recording: start/stop function key.
➔ The recording is sent to your e-mail address.

Note:
The LED on the function key remains lit while the recording is in progress. The LED 
starts to flash before the recording reaches its maximum preset duration. Once the 
maximum duration is reached (or the memory is full), the recording is stopped and 
the LED goes off (Aastra 6865i only).

Menu Description

Do not disturb (busy) on/off Your phone does not ring and is set to busy for incoming calls.

Do not disturb (forwarding) 
on/off

Your phone does not ring and is set to busy for incoming calls. Incoming calls 
are automatically forwarded to a destination that has been configured by 
your system administrator.
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This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

Using further functions
This section explains some more convenient features provided by your phone. All 
the functions you can save under a configurable key can be found in chapter 
"Overview of available functions", page 44.

Activating personal call routing

You want to specify which of your phone shall ring when you receive a call.

If your system administrator has set up a phone number with several phones for you as 
well as the five call routings (One-number user concept, see chapter "One number user 
concept", page 7), you can specify which of your phones shall signal a call by using the 
personal call routing. You can only answer a call on phone where the call is signalled. 
Contact your system administrator for more information.

You can activate a call routing for all phones. If you have not configured a call routing, 
the default setting (all phones are ringing) is used as standard.

Operation of personal call routing is available via the system menu. The function can 
also be configured to a function key by your system administrator (see chapter "Config-
uring keys", page 69) or by yourself in the Aastra Self Service Portal (see chapter "Aastra 
Self Service Portal", page 7).

The following options are available for further editing of the personal call routing:

Do not disturb on/off Activating/deactivating do not disturb:
Press the function key for Do not disturb (busy) on/off or Do not disturb (forwarding) 
on/off.
➔ The function is activated/deactivated. The LED on the function key is switched 

on/off (Aastra 6865i only). Your callers hear the busy tone.

Menu Description

Activate Activating personal call routing.

Modify Renaming personal call routing.

Change settings
The personal call routing settings can only be changed by your system 
administrator or yourself in the Aastra Self Service Portal.

Delete
A personal call routing can only be deleted by your system administrator or 
yourself in the Aastra Self Service Portal.
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You can also store your individual call routing profiles on a function key and quickly acti-
vate or deactivate your desired call routing profile by simply pressing that key.

Activating ring alone

You want to specify which of your phone shall ring when you receive a call.

When your system administrator has set up a phone number with several phones (One-
number user concept, see chapter "One number user concept", page 7), you can define 
on which phones a call shall acoustically be signalled using ring alone. When you have 
activated ring alone on a phone, the acoustic ringing tone is deactivated for all other 
phones. An incoming call is signalled in the display of all phones. You can answer the 
call on each of your phones.

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

Menu
Press the function key for Menu.

Call Routing Scroll to Call routing and press the navigation key to the right.
➔ A list of your routings is displayed.

Activate Activating/deactivating personal call routing
Select the call routing you want and confirm with the Activate > Enter.
➔ The selected routing is activated and another is deactivated.

Modify Renaming personal call routing:
1. Select the call routing you want and confirm with the Modify > Enter.
2. Enter the name and confirm with the Enter softkey.

<Call routing profile> Press the function key for the desired call routing profile.
➔ Call routing is activated/deactivated. The LED on the function key is switched 

on/off (Aastra 6865i only).

Note:
When you have activated ring alone but deactivated the personal call routing for a 
phone in parallel, an incoming call is not acoustically but only visually signalled.

Ring Alone on/off Activating/deactivating ring alone
Press the function key for Ring Alone on/off.
➔ The function is activated/deactivated. The LED on the function key is switched 

on/off (Aastra 6865i only).
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Locking/Unlocking your phone

You need to leave your desk and want to ensure that no-one can alter your phone's set-
tings, look at your private data, or make calls from your phone.

You can lock your phone with a PIN consisting of two to ten digits, (see chapter "Chang-
ing the PIN", page 63).

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

Acknowledging an appointment call

You can set a call to remind you about an appointment, for example Appointment call is 
displayed as soon as it is received. Without an acknowledgement the appointment call 
will ring for 1 minute.

The following options are available options: You have to enter or change the time in the 
Aastra Self Service Portal.

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

Phone lock on/off Activate the phone lock:
Press the function key for Phone lock on/off.
➔ The phone is locked and can only be unlocked using your PIN.

Phone lock on/off Deactivate the phone lock:
1. Press the function key for Phone lock on/off.
2. Enter the PIN and confirm with the Enter softkey.
3. Unlock the security prompt with the Unlock softkey.

Note:
Use the following function codes (see also "User’s Guide Function Codes" on the 
Aastra DocFinder) to activate or deactivate the phone lock for all phones within the 
one number user concept (see chapter "Purpose and function", page 72):
• Activate the phone lock: Enter the function code *33* <PIN> #
• Deactivate the phone lock: Enter the function code #33* <PIN> #

Menu Description

Single appointment call 
on/off

Activate appointment call on a one-off basis.

Repeat appointment call 
on/off

Activate appointment call permanently
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Free seating

Free Seating is proposed for workplaces/phones shared by several employees. It allows 
you to log in on each free free seating phone and to use it with your personal settings as 
long as your logged in. Ask your system administrator which phones are proposed for 
free seating.

Log in:

You log in with your call number and your PIN on a free seating phone. Once you are 
logged in, your personal call lists, phone book and all your other personal settings and 
Hotkeys are available to you immediately. If your profile contains expansion key mod-
ules, but the phone you have logged in to does not, the keys in question will not be 
available to you. Various sequences of expansion key modules are correctly recognised.

Notes:
• If you activated forwarding, the appointment call is not forwarded.
• If you are in call, the appointment call is made as soon as you end the call.

Appointment call Activates/deactivates appointment call permanently:
Press the function key for Appointment call.
➔ The function is activated/deactivated. The LED on the function key is switched 

on/off (Aastra 6865i only).

Appointment call Activate single appointment call:
Press the function key for Appointment call.
➔ The function is activated/deactivated. The LED on the function key is switched 

on/off (Aastra 6865i only).

Confirming an appointment call:
Pick up the handset and then hang up immediately.
➔ The appointment call is confirmed and ended.

Notes:
• You can only log in to a phone if no other user has yet logged in to that phone for 

free seating purposes.
• You can only log on once to a Free Seating phone. The moment you log in to 

another free seating phone, you are automatically logged off the original phone.
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Log out:
To free up a phone, you need to log off again. To ensure a phone is not blocked for other 
users if you forget to log off, your system administrator can set up a logoff process with 
an automatic time limit:

• After a certain amount of time after login (e.g. after 6 hours and 30 minutes).
• At a certain time (e.g. 6.30pm)

Hotline

The hotline is typically used for lift phones, emergency phones, or for baby alarms or 
hotline in the hospitality/hotel branch.

A user needs help and picks up the handset or presses the Loudspeaker key. The user is 
automatically routed to the preconfigured hotline destination number stored in the 
Aastra 400 communication system. The person responsible answers the call and is con-
nected with the user seeking help.

Notes:
• If no user is currently logged in a free seating phone possibly only allows emer-

gency calls.
• As long as you do not have your own phone or are not logged on to a Free Seating 

phone, your caller will obtain either the busy signal or be forwarded to a precon-
figured destination, depending on the system configuration.

Free seating: Log in/out Log in free seating:
Press the Free Seating: Log in/out softkey.

<Call number, PIN> Enter phone number and PIN and confirm with the OK softkey.
➔ You are now logged in and can use the free seating phone with your personal 

settings. The LED on the function key lights up (Aastra 6865i only).

Note:
The default PIN setting ‘0000’ is not accepted (for more information on the PIN, see 
chapter "Changing the PIN", page 63).

Free seating: Log in/out Log out free seating:
Press the Free Seating: Log in/out softkey.
➔ The display with the call number is displayed.
Depending on the system configuration enter the PIN and confirm with the Ok 
softkey.
➔ You are now logged off; the free seating phone is now available again to other 

users.

Note:
You are automatically logged off if your system administrator has set up an auto-
matic logoff process.

☛
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Alarm cancellation delay: Your system administrator can set a delay (0-60 seconds, 
depending on the Aastra system phone). During this delay the user can enter another 
call number in order not to trigger a call on the hotline destination number. If the user 
does not dial another phone number during this predefined time or puts the handset 
back down again, a connection with the Hotline number is automatically set up. Con-
tact your system administrator for more information.

Overview of available functions
This section contains a list of all the functions you can store under a configurable key via 
the Aastra Self Service Portal.

More information on how to store functions under a configurable key using function 
commands and function codes can be found in the Aastra Self Service Portal online help 
(see chapter "Aastra Self Service Portal", page 7).

Using the hotline:
User needs help. He picks up the handset of his phone or presses the Loudspeaker 
key.
➔ A connection with the hotline number is automatically set up after a prede-

fined time without the user having to do anything else.

Function Description

Announcement to group

Speak directly to a group of internal users via the loudspeaker - 
where available - without them having to first pick up the call. An 
announcement is a one-sided connection and is indicated by two 
short signal tones on the recipient phone. Announcement groups 
will be defined by your system administrator. The group number 
must be entered as two digits.

Announcement to user

Speak directly to an internal user via the loudspeaker - where avail-
able - without them having to first pick up the call. An announce-
ment is a one-sided connection and is indicated by two short signal 
tones on the recipient phone.

Appointment call: Repeat on/off
Activates/deactivates an appointment call (see chapter "Acknowl-
edging an appointment call", page 41).

Appointment call: Single on/off
Activates/deactivates an appointment call on a one-off basis (see 
chapter "Acknowledging an appointment call", page 41).

Call forw. (CFU) to pager on/off Incoming calls are automatically forwarded to a specific destination.

Call forw. (CFU) to user on/off Incoming calls are automatically forwarded to a specific destination.

Call forw. (CFU) to VM on/off Incoming calls are automatically forwarded to a specific destination.

Call forw. if busy (CFB) to user on/off
If you are busy, incoming calls will be forwarded to specific destina-
tion (user).
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Call forw. if busy (CFB) to VM on/off
If you are busy, incoming calls will be forwarded to specific destina-
tion (voice mail).

Call forw. on no reply (CFNR) to pager 
on/off

Incoming calls are automatically forwarded to another destination 
(pager).

Call forw. on no reply (CFNR) to user 
on/off

Incoming calls are automatically forwarded to another destination 
(user).

Call forw. on no reply (CFNR) to VM 
on/off

Incoming calls are automatically forwarded to another destination 
(voice mail).

Call forwarding menu
Direct access to the Forward system menu (see chapter "Call for-
warding", page 49).

Call forwarding protection on/off Call forwarding to your phone is not allowed.

Call list menu Direct access to the system menu Call list.

Call list: Answered calls Call list for answered calls.

Call list: Redial list Call list for dialled call numbers.

Call list: Unanswered calls Call list for unanswered calls.

Call recording: Start/stop Record a call. The recordings are stored in your individual e-mailbox 
only ( see chapter "Recording a call", page 49).

Call transfer Transfer a call to another user with or without prior notice.

Conference: Set up Set up a conference with two call parties.

Control output on/off

You can control external electric equipment or installations using 
control outputs. For example you can use your phone to open and 
close electric gates or to switch the lights on or off throughout a 
building.

Do not disturb (busy) on/off Your phone does not ring and is set to busy for incoming calls.

Do not disturb (forwarding) on/off
Your phone does not ring and is set to busy for incoming calls. 
Incoming calls are automatically forwarded to a destination that has 
been configured by your system administrator.

Empty The key assignment is configured with an empty function. The key is 
not overwritten by the following key assignments.

Free configurable

You can use function commands to define a function to suit your 
personal requirements. A function can consist of one or more func-
tion commands, function codes, and the phone number. You can 
either carry out a function directly or store it under a key.

Free seating: Log in/out Log in/out on a free seating phone (see chapter "Free seating", 
page 42).

Hide number on/off
Permanently prevents your call number from being displayed to the 
caller (see chapter "Hide number", page 31).

Hide number per call
Prevent your call number from being displayed to the caller once 
(see chapter "Hide number", page 31).

Function Description
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Home Alone on/off

If calls to a user group can only be answered by one user, the user in 
question can activate Home Alone on the user group. Then if the 
user is already in a call, all subsequent internal or external calls to the 
user group obtain a busy tone.

Personal call routing menu
Direct access to the system menu Call routing (see chapter "Activat-
ing personal call routing", page 39).

Personal call routing on/off
Activate/deactivate call routing profile (under the one number user 
concept).

Phone book: Local
Access to your local phone book. Contacts in the local phone book 
are stored on the phone only (see chapter "Phone books manage-
ment", page 65).

Phone book: System
Direct access to the Directory Lookup system menu. Contacts in the 
system phone book are integrated in the Aastra 400 communication 
system (see chapter "Phone books management", page 65).

Phone lock on/off
Activate/deactivate phone lock. Outgoing calls are not possible, but 
incoming calls can be answered (see chapter "Locking/Unlocking 
your phone", page 41).

Picking up a call from a user group Pick up a call for another user in the user group.

PIN call
Function with OpenCount. Independently from the phone you can 
make external calls for a fee. The credit may be limited (see chapter 
"Activating PIN telephony", page 56).

PIN call rebook
Function with OpenCount. You can charge the charges and the call 
information of your outgoing and incoming calls to specific projects 
(see chapter "Activating PIN telephony", page 56).

Presence menu Direct access to the system menu Presence (see chapter "Controlling 
the presence status", page 47).

Presence profile on/off
Activate/deactivate presence profile. You can select a presence pro-
file (profile number 1-4, see chapter "Controlling the presence sta-
tus", page 47).

Remote maintenance on/off Allow permanent remote management access on your phone.

Remote maintenance onetime on/off Allow one-time remote management access on your phone.

Request a callback Request a callback if the called party is busy or cannot be reached 
(see chapter "Requesting a callback", page 29).

Ring Alone on/off
This function lets you specify which of your phones signals incoming 
calls acoustically (as part of the one-number user concept, see chap-
ter "Activating ring alone", page 40).

Show alarm state Display of the current alarm state.

Switch group x, position 2
Switch group x, position 3

This function lets you route calls and functions via switch groups 
(with two switch positions).

System menu Access to the Aastra 400 system menu.

Function Description
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Organising absences from the desk
This section explains the different options provided by your phone when you want 
to leave your desk.

The presence function enables you on the one hand to quickly set your personal 
presence state and hence to route the incoming calls to the destination you want. 
It also tells you directly whether the user you want is reachable or absent without 
you having to call him. The information details depend on the type of telephone.

Controlling the presence status

You have a choice of 5 presence profiles for controlling your presence status:

Take (pick up own call)
Take a call from your phone on another phone under the one num-
ber user concept (see chapter "Take (pick up own call)", page 35).

Transparent data This function takes charge of the transparent exchange of data 
between the communication server and external applications.

User group all: Log in/out
Log in/out of all user groups. In the user group incoming and inter-
nal calls are routed to a group of internal destinations according to a 
preconfigured call distribution.

User group: Log in/out
Log in/out of a user group. In the user group incoming and internal 
calls are routed to a group of internal destinations according to a 
preconfigured call distribution.

Voice mail greeting on/off Activates/deactivates a selected voice mail greeting.

Voice mail greeting: Play Plays back a selected voice mail greeting.

Voice mail greeting: Record Records a selected voice mail greeting.

Voice mail menu Direct access to the Voice mail system menu.

Welcome announcement on/off

Announcement service for incoming internal and external calls. If 
you do not answer an external call after a set delay, the user who is 
calling will obtain an announcement. After the announcement the 
caller will then hear the ring-back tone again.

XML function: Run
You system administrator creates customer-specific XML services 
(weather report, stock exchange, etc.) which you can use on your SIP 
phone.

Function Description
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You can call up the presence of the user you want in the following situations.

• in the phone book or in a call list;
• during dialling by name;
• in presence menu.

Operation of the presence status is available via the system menu, a function key (see 
chapter "Configuring keys", page 69), or the Aastra Self Service Portal (see chapter 
"Aastra Self Service Portal", page 7).

Absence information

You wish to give your caller detailed information about your absence.

If you have configured call forwarding to voice mail in your presence profile, you can 
choose whether the currently active greeting, the global greeting, one of your personal 
greetings or an absence information should be played back to the caller.

Profile number Presence profile

0 Available

1 Absent

2 Meeting

3 Busy

4 Not available

Notes:
• Connected CTI applications can affect your presence status. Contact your system 

administrator for more information.
• All configuration options for a presence profile can be found in chapter "Config-

uring presence profile", page 68.

Menu To deactivate the presence profile:
Press the function key for Menu.

Presence
Scroll to Presence and press the navigation key to the right.

Activate 1. Select the presence profile you want and press the Enter softkey.
2. Press the Activate > Enter softkey.
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Absence information is available for each presence profile, with the exception of  Availa-
ble. Absence information consists of a language-dependent, predefined audio text. The 
time and/or date are also given as an option. Depending on the voice mail configuration 
your caller then has immediately the possibility of leaving a message.

Example: "The person you have called is not available until 31st January, at 14:00. 
Please leave a message after the tone".

The absence information is an integral part of a presence profile. All the relevant config-
uration possibilities can be found in chapter "Configuring presence profile", page 68.

Call forwarding

You want to leave your desk. Calls for you are to be forwarded to a different destination 
(e.g. another user, your voice mail). With a call forwarding you can forward incoming calls 
directly to a different destination.

Note:
If your Outlook calendar is not synchronised via Open Interfaces Platform (OIP) with 
your communication server, you have to manually enter and delete the time and 
date.

Menu Set up the absence information:
Press the function key for Menu.

Presence
Scroll to Presence and press the navigation key to the right.

Modify 1. Select the presence profile you want and press the Execute softkey.
2. Scroll to Modify and press the Enter softkey.

<Absence information> 1. Scroll to Time respectively to Date and press the Enter softkey.
2. Make the changes and confirm with the Enter softkey.
3. Scroll to Call forwarding and press the Enter softkey.
4. Select Voice mail and confirm with the Enter softkey.
5. Scroll to VM greeting and press the Enter softkey.
6. Select Absence info and confirm with the Enter softkey.
7. Activate the presence profile.
➔ Settings are saved. Your caller hears the selected absence information, fol-

lowed, if applicable, by time and date.

Notes:
• One call forwarding applies to all connected phones, in one number user concept.
• Only one call forwarding variant at a time is possible.
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Available call forwarding types possibilities:

Available call forwarding destinations:

Operation of the call forwarding is available via the system menu, a function key (see 
chapter "Configuring keys", page 69), or the Aastra Self Service Portal (see chapter 
"Aastra Self Service Portal", page 7).

Menu Description

No call forwarding (Call for-
warding off)

No CFU is carried out.

Always call forwarding, CFU 
(Always (CFU))

Incoming calls are automatically forwarded to another destination.

Call forwarding if busy, CFB 
(If busy (CFB))

Incoming calls are forwarded directly to a different destination if you are 
busy.

Call Forwarding on No Reply Incoming calls are automatically forwarded to another destination. Both 
your own phone and the other destination will then start ringing. The sys-
tem configuration determines whether or not there is a ringing delay at the 
other destination. Whoever goes off-hook first, answers the call. Depending 
on the system configuration, Call Forwarding on No Reply can also be acti-
vated when your phone is busy.

Menu Description

User Incoming calls are forwarded to an internal user or a call number.

Voice Mail Incoming calls are forwarded to your voice mail, providing it has been set up 
by your system administrator.
You can use the global greeting or your own greeting (see chapter "Config-
uring voice mail", page 66). For further information on voice mail refer to the 
"User’s Guide Voice Mail Systems" on the Aastra DocFinder.

Menu Activate call forwarding:
Press the function key for Menu.

Forwarding
Scroll to Forwarding and press the navigation key to the right.

<Call forwarding>
Select the call forwarding variant you want and confirm with the Enter softkey.
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Operating call lists and voice messages
In this section you will learn how to use call lists and voice messages which are 
stored in the Aastra 400 communication system.

Editing options for the call list

The call lists (unanswered/answered calls and redial list) include a maximum of 30 
entries each. The following options are available for further editing of the entries:

The call lists can be operated via the Call lists key, the system menu or a function key, or 
via the Redial key (see chapter "Configuring keys", page 69).

Information on call lists can be found in the chapter "Dialling from the call list", page 26.

<Destination> Select or enter the forwarding destination you want and confirm with the Enter 
softkey.
➔ The call forwarding is activated.

Note:
You can also enter the call number of the user you want manually or find it in a call list.

Deactivate call forwarding:
Call forwarding unconditional can be deactivated via: Menu > Forwarding > for-
warding variant Forwarding off.

Call list Description

Delete all Deleting all entries from a specific call list.

Detail Available detailed information:
• Call number / name
• Call date and time
• Number of call attempts
• Presence status of the user

Delete Delete entry.
Note:
If you delete an entry in the unanswered calls list, then any voice messages 
for this entry are also deleted. Entries with voice messages that have not 
been retrieved cannot be deleted.

Dial Calling a user back.

Options in the call list:
Press the call list button.

<Call list> 1. Scroll to the call list you want and press the Enter softkey.
2. Scroll through the list until the user you want is displayed.
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Editing options for voice messages

Your display shows the envelope symbol and the number of new voice messages. The 
message LED flashes red slowly.

The following options are available for further editing of the voice messages:

Operation of the voice messages is available via the system menu, a function key (see 
chapter "Configuring keys", page 69), or the Aastra Self Service Portal (see chapter 
"Aastra Self Service Portal", page 7).

Calling a user from the call list:
Pick up the handset.
➔ The call number of the user is dialled. Once the call has been successfully con-

nected, the user is deleted from the unanswered call list.

Detail Calling up detailed information on an entry:
1. Select the entry you want and press the Enter softkey.
2. Call up detailed information with the Detail > Enter softkey.

Delete Deleting an entry from the call list:
1. Select the entry you want and press the Enter softkey.
2. Delete the entry with the Delete > Enter softkey.

Delete all Deleting all entries from the call list:
1. Select an entry and press the Enter softkey.
2. Delete all entries with the Delete all > Execute softkey.

Menu Description

Detail Available detailed information:
• Call number / name
• Call date and time

Delete Delete voice message

Forward Forwards a voice message to another user. You can decide whether to keep 
a copy of each voice message.

Play Play voice message.

Notes:
• Depending on the system configuration your system administrator can specify 

that you are notified by e-mail whenever you receive a new voice message (with 
the voice message attached). Contact your system administrator for more infor-
mation.

• To find out how to configure a voice mail, refer to the chapter "Configuring voice 
mail", page 66 or to the "User’s Guide Voice Mail Systems" user's guide on the 
Aastra DocFinder.
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 Phoning
Organisation within the team (busy lamp field, 
Aastra 6865i only)
This section explains the different options provided by your phone to communi-
cate in a team.

Using the busy lamp field key

You and your team partners want to be reachable at all times as a team and be able to 
communicate with one another as quickly as possible.

By pressing a single key you can call a team partner or answer a call for anyone in the 
team. When a team partner makes a call, the LED for the corresponding busy lamp field 
key lights up. This tells you when a team partner is busy. The busy lamp field key LED 
flashes to indicate that the team partner is receiving a call.

To be able to use the busy lamp field key, it must have been configured as such with the 
call number of the team partner, either by your system administrator or by yourself in 
the Aastra Self Service Portal (see chapter "Configuring keys", page 69).

Menu Options in the voice mail:
Press the function key for Menu.

Voice Mail Scroll to Voice Mail and press the navigation key to the right.
➔ The list of received voice messages is displayed.

Play Play voice message:
1. Select the entry you want and press the Enter softkey.
2. Play the entry with the Play > Enter softkey.

Detail Calling up detailed information on a voice message:
1. Select the entry you want and press the Enter softkey.
2. Call up detailed information with the Detail > Enter softkey.

Delete Delete voice message:
1. Select the entry you want and press the Enter softkey.
2. Delete the entry with the Delete > Enter softkey.

Forward Forwarding voice messages:
1. Select the entry you want and press the Enter softkey.
2. Press the Forward > Enter softkey.
3. Select the call number you want and press the Enter softkey.
4. If you wish to keep a copy of the voice message, answer the questions with the 

End > Yes > Enter softkey.
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Calling a team partner

You want to call a team partner as quickly as possible.

Answering a call for a team partner

Your team partner is called. The LED on the busy lamp field key flashes. You know that 
your team partner is not at his desk at present and therefore decide to answer the call.

You take over the call by pressing the busy lamp field key. As soon as you have answered 
the call, your team partner is free again.

Line key on a key telephone
This section explains the different options provided by your phone when your sys-
tem administrator has assigned one of more configurable keys as KT line keys. KT 
line keys make your phone a key telephone.

A KT line[a] has a number which can be used for internal or external calls. One or usually 
multiple phones can be connected to this KT line, for example in all employees in a 
travel agency who work with Europe as a destination. The KT line key belonging to the 
KT line shows the status of the KT line through an LED and allows you to accept calls 
which are made to this KT line.

Your phone becomes a key telephone as soon as your system administrator has 
assigned a KT line to a configurable key. With the configuration of a KT line key, your sys-
tem administrator will also set up a personal line on which you can make your personal 
calls.

KT lines are only possible on function keys T1 to T20 (Aastra 6867i) or T1 to T40 
(Aastra 6869i).

Calling a team partner:
Press the busy lamp field key of the team partner.
➔ The phone number and possibly the name of the team partner appear on the 

display. The team partner is called.

Answering a call for a team partner:
Pick up the handset as long as the busy lamp field key LED is flashing.
➔ You hear the dialling tone.

Press the busy lamp field key.
➔ You are through to the person who is calling your team partner.
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Answering a call on the KT line key

You are being called on one or more KT line keys. The KT line key(s) flash quickly. You 
want to answer a call on a KT line key.

If you want to answer a call on another KT line key first, press this KT line key in order to 
pick up the call. If you pick up the handset without pressing a KT line key, you will be 
connected to the highest priority KT line.

Initiating a call via a KT line key

You want to make a call via a KT line key.

You can call via any free KT line key. Each KT line key has its own call number. This means 
that, by phoning, you transmit the call number associated with the active KT line key.

Charges are accrued separately for each KT line key.

Pick up the handset.
➔ Connection to the KT line with the highest priority.
Or:
1 Press a KT line key.
➔ KT line is selected.
2 Pick up the handset.
➔ Connection to the selected KT line.

<Call number>
Enter the phone number.

Press a free KT line key.
➔ The LED on the KT line key lights up. KT line is selected.

Pick up the handset.
➔ The phone number is dialled.

☛
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Using functions with OpenCount
OpenCount is a software package used for the call logging management on the 
communication system. The application can be integrated into your Aastra 400 
communication system and enables the logging, the administration, and the anal-
ysis of all call and connection data.

If an OpenCount is integrated in your Aastra 400 communication system, the fol-
lowing additional features are also available on your phone.

Activating PIN telephony

The PIN telephony is part of OpenCount. The possible applications of the PIN telephony 
depend on the area of use, for example in the area of health care and accommoda-
tion/hotel:

• Independently from the phone you can make external calls for a fee. The credit may 
be limited.

• You can charge the charges and the call information of your outgoing and incoming 
calls to specific projects.

This function must be stored under a function key (see chapter "Configuring keys", 
page 69).

For further information refer to the product-specific OpenCount user's guides on our 
website (www.aastra.com) or contact your system administrator.

PIN call / PIN call rebook Activating/deactivating PIN call:
Press the function key for PIN call / PIN call rebook.
➔ The function is activated/deactivated. The LED on the function key is switched 

on/off (Aastra 6865i only).
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Setting functions by remote control
This section explains how you can alter your phone’s settings even if you are not 
directly at your phone.

You are not at your desk and want to set various functions on your phone from a differ-
ent phone.

You can activate/deactivate many of your phone's functions by remote control from a 
different phone.

The remote control is initiated using a special function code. You can then enter the 
function commands and function codes.

<Function code> Using remote control from a third-party phone:
1. Enter function code #06.
2. Enter your phone number.
3. Enter your PIN.
4. Enter the function code for activating/deactivating the function you want.

Pick up the handset.
➔ You hear the acknowledgement tone.

Put the handset on-hook.
➔ The function is activated/deactivated.

Note:
The default PIN setting ‘0000’ is not accepted (for more information on the PIN, see 
chapter "Changing the PIN", page 63).

☛
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These sections explain how to adapt the phone’s basic settings to suit your per-
sonal requirements.

Configuring the display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Configuring the audio properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Configuring general phone settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Protecting yourself against calls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65

Phone books management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65

Configuring voice mail. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66

Configuring presence profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68

Configuring keys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
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Configuring the display
This section explains how to set display properties.

Setting the display

You may find the display is too bright or too dark.

You can adapt the display to suit your personal requirements with the following settings:

Configuring the audio properties
This section explains how to set audio properties.

Adjusting the volume

You want to change the volume of the ring tone or the handset during a call.

Display Description

Contrast level Setting the display contrast.

Backlight (Aastra 6865i only): Setting the backlight:

• Off • The backlight is always deactivated.

• Auto • The backlight is switched on automatically when the phone is used 
and switched off automatically when the phone is in an idle state for a 
certain period of time.

Press the Option key.

Preferences
Scroll to Preferences and press the navigation key to the right.

Display
Scroll to Display and press the navigation key to the right.

Contrast level Setting the contrast:
1. Scroll to Contrast level and press the navigation key to the right.
2. Set the desired contrast using the horizontal navigation key and confirm 

with the Select softkey.

Backlight Setting the backlight:
1. Scroll to Backlight and press the navigation key to the right.
2. Select the required setting and confirm with the navigation key to the right.
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Ring volume: You can adjust the volume when in the idle state or when the ring tone 
sounds. Press and hold the volume down button to switch off the ring tone completely.

Handset volume: You have to set the volume of handset and loudspeaker separately. 
The new volume will remain stored even after the call is ended.

Setting the ringing properties

You want to change the way in which your phone rings. Available settings:

Adjusting the volume (in idle state, during ringing phase/call):
Quieter: Press the  key.
Louder: Press the  key.

Ring tones Description

Tones:

• Ring tone 1...15 • Selection of available ring melodies.

• Silent • If you do not want to be disturbed during a certain time, you can set your 
phone not to ring with Suppress ring tone.

Tone set Country-specific ring tone settings. This menu is set by your system admin-
istrator.

Setting the ring:
Press the option key.

Preferences
Scroll to Preferences and press the navigation key to the right.

Tones
Scroll to Tones and press the navigation key to the right.

Ring tone 1. Scroll to Ring tones and press the navigation key to the right.
2. Select the setting you want and confirm with the Set softkey.

Note:
A list of alarm melodies is available for playback: Menu > Alarm melodies > Test.
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Setting the audio properties

Using your phone, you can make and answer calls using the handset, headset or hands-
free system. The audio settings allow the use of different combinations of these three 
operation modes in order to achieve maximum flexibility in phone operation. The fol-
lowing options are available for selection:

Audio settings Description

Audio Mode1):

1) All setting possibilities for the headset only apply to the Aastra 6865i.

Setting possibilities:

• Speaker • The connection is made via loudspeaker. The LED on the loudspeaker key 
stays lit.

• Headset • The connection is made via headset. The LED on the loudspeaker key 
flashes slowly.

• Speaker/Headset • The connection is made via handsfree system. The LED on the loud-
speaker key lights up. Press the handsfree key to switch to the headset.

• Headset/Speaker • The connection is made via headset. The LED on the loudspeaker key 
lights up. Press the handsfree key to switch to handsfree mode.

Headset Mic Vol Sets the volume of the headset microphone.

DHSG Activate/deactivate DHSG.
Phoning using a cordless headset based on the DHSG standard allows you to 
set up and to end calls from the headset. Ask your dealer which headsets are 
particularly well suited for this phone.
To avoid damages on the phone always disconnect the phone from the 
mains power first before you install a DHSG headset.

Notes:
• To find out how to make phone calls with the headset, refer to the chapter "Using 

a headset (Aastra 6865i only)", page 23.

Press the Option key.

Preferences
Scroll to Preferences and press the navigation key to the right.

Set Audio
Scroll to Set Audio and press the navigation key to the right.
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Configuring general phone settings
This section explains other settings you can make on your phone.

Selecting the language

You wish to select a different user language for your display.

The user language on your phone is configured using the Aastra Self Service Portal. For 
more information about the Aastra Self Service Portal, please refer to chapter "Aastra 
Self Service Portal", page 7.

The language selection is limited to five languages. If the language you want is not avail-
able, then your system administrator can upload additional language packs. English is 
the standard language and is contained in every language pack.

Selecting the time and date

The settings for the time and date are made by your system administrator. The following 
chapter is thus intended for your system administrator or technician, who will then set 
the time and date for you.

As system administrator or technician, you can make global settings for the time and 
date for all Aastra SIP phones in the Aastra 400 communication system. If no NTP time 
server is entered in the communication system, then you can also make these settings 
over the phone. Available settings:

Audio mode Setting the audio mode:
1. Scroll to Set Audio and press the navigation key to the right.
2. Select the setting you want and confirm with the Set softkey.

Headset Mic Vol Setting the headset volume (Aastra 6865i only):
1. Scroll to Headset Mic Vol and press the navigation key to the right.
2. Select the setting you want and confirm with the Set softkey.

Setting Description

Time format 12-hour or 24-hour clock format.

Daylight savings List of available summer time formats.

Date format List of available date formats.

Time zone List of available global time zones.
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Using Live Dialpad (single-digit dialling)

Activates or deactivates the Live Dialpad. This local function is not supported by the 
Aastra 400 communication system.

Using speed dial edit

Menu for configuration of the keypad speed dial. This local function is not supported by 
the Aastra 400 communication system.

Changing the PIN

You want to change the PIN used to lock/unlock your phone and protect your phone 
settings (more information about locking/unlocking your phone can be found in chap-
ter "Locking/Unlocking your phone", page 41).

The digit combination "0000" is set as default. You can select any 2 to 8-digit combina-
tion for your new PIN. The PIN on your phone is changed using the Aastra Self Service 
Portal. For more information about the Aastra Self Service Portal, please refer to chapter 
"Aastra Self Service Portal", page 7.

Time server 1-3 Setting menu for the IP address or domain name of the time server. If a valid 
time server is set, then the phone synchronises the displayed time with the 
specified configuration server. The phone adopts the time from time server 
1. If this is not configured or cannot be reached, then the phone queries first 
time server 2 and then 3.

Press the Option key.

Preferences
Scroll to Preferences and press the navigation key to the right.

Time/date
Scroll to Time/date and press the navigation key to the right.

<Setting>
Scroll to the setting you want and press the navigation key to the right.

Set
Select the setting you want and confirm with the Set softkey.

Setting Description
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Enter the display text for the idle state

You want to change the text displayed by your phone in the idle state.

The display text shown in the idle state on your phone is configured using the Aastra 
Self Service Portal. For more information about the Aastra Self Service Portal, please 
refer to chapter "Aastra Self Service Portal", page 7.

Local IP settings

The specific data for your phone, such as IP address or memory, is stored in the option 
key menu > or Menu > Information. The input of this data is password-protected; it can 
therefore only be carried out by your system administrator. You can however call up the 
data.

Restarting the phone

You want to restart your phone. You have to restart your phone after the following 
actions:

• Uploading a new language pack or updating a newly selected language.
• Uploading new phone software.
• Confirming new settings.

Note:
The PIN you have locally changed in your phone cannot be overwritten via the 
Aastra Self Service Portal.

Calling up the phone status:
Press the Option key.

Phone status Scroll to Phone status and press the navigation key to the right.
➔ Settings are displayed.

Menu Calling up the system menu:
Press the Menu softkey.

Information Scroll to Information and press the navigation key to the right.
➔ Settings are displayed.
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Protecting yourself against calls
The protection function helps to protect yourself against other users applying 
telephony features on you via menu guidance or using function codes.

Activating protection against call types

You want to protect yourself against certain types of calls.

A function key can be configured for the call forwarding protection function (see chap-
ter "Activating do not disturb", page 38).

Protection for all other call types is configured using the Aastra Self Service Portal. For 
more information about the Aastra Self Service Portal, please refer to chapter "Aastra 
Self Service Portal", page 7.

Phone books management
This section includes important information on your phone books.

Selection

If your phone is connected to an Aastra 400 communications system, then the following 
phone books can be selected:

System phone book:

The system phone book contains the contacts of the users on the Aastra 400 communi-
cation system and your private contacts, to which only you have access. It is integrated 
into the Aastra 400 communication system by your system administrator.

With the help of quickdial and dialling by name in the system phone book, you can 
search for and call both a contact in the Aastra 400 communication system and in your 
private phone book.

Local phone book:

Press the Option key.

Restart phone 1. Scroll to Restart phone and press the navigation key to the right.
2. Answer the security question with Yes.
➔ The phone is restarted.
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Aside from the system phone book, your phone also has a local phone book. This can be 
assigned to a function key.

The local phone book is not supported by the Aastra 400 communication system. This 
implies that contacts saved in this local phone book are only available on your Aastra SIP 
phone. The search function in the system phone book (quickdial and dialling by name) 
does not search in the local phone book.

Private contacts:

We recommend using the following products to manage your private contacts:

• Aastra Self Service Portal (see chapter "Aastra Self Service Portal", page 7).
• Aastra OfficeSuite
• External directories, such as Microsoft Exchange (provided your Aastra 400 commu-

nication system is synchronised with external directories).

Configuring voice mail
This section explains how to set your voice mail.

Managing personal voice mail greeting

Depending on the system configuration you have the possibility to record up to 3 differ-
ent greetings (e.g.for Absent or Vacation). Give each greeting the relevant name. 
Depending on the system configuration a caller may or may not be able to leave a mes-
sage (for the symbols see mode).

If no personal greeting is activated or if none is available, the global greeting is activated 
automatically, provided it has been recorded. For further information on voice mail refer 
to your system administrator or the "User’s Guide Voice Mail Systems" on the Aastra 
DocFinder.

The following options are available for further editing of your voice mail greetings:

Note:
Searching using the phone books is explained in more detail in the chapter "Dialling 
from the phone book (directory lookup)", page 24.

Menu Description

Record Record voice mail greeting.

Select Activating the voice mail greeting.
66 Aastra 6863i / Aastra 6865i
eud-1629/1.1 – R3.2 – 10.2014

http://www.aastra.com/docfinder
http://www.aastra.com/docfinder


 Personalizing your phone
Operation of voice mail is available via the system menu, a function key (see chapter 
"Configuring keys", page 69), or the Aastra Self Service Portal (see chapter "Aastra Self 
Service Portal", page 7).

Edit Renaming the voice mail greeting.

Mode: Selecting the mode:

• Recording allowed Caller can leave a message.

• Recording not allowed Caller cannot leave a message.

Play Play voice mail greeting

Menu
Press the function key for Menu.

Voice mail
Scroll to Voice Mail and press the Enter softkey.

Select any entry and press the Execute softkey.

Settings
Scroll to Settings and press the Enter softkey.

Edit Renaming the voice mail greeting:
1. Select the greeting you want and press the Enter softkey.
2. Press the Edit > Enter softkey.
3. Enter the name and confirm with the Enter softkey.

Record Recording voice mail greeting:
1. Select the greeting you want and press the Enter softkey.
2. Press the Record > Enter softkey.
3. Pick up the handset and record your own personal greeting.
4. Stop the recording using the Done softkey.

Play Playing voice mail greeting:
1. Select the greeting you want and press the Enter softkey.
2. Press the Play > Enter softkey.
3. You can monitor your personal greeting text and re-record it if necessary.

Mode Selecting the mode:
1. Select the greeting you want and press the Enter softkey.
2. Press the Mode > Enter softkey.
3. Select the mode you want and confirm with the Enter softkey.

Select Activating the voice mail greeting:
1. Select the greeting you want and press the Enter softkey.
2. Confirm with the Select > Enter softkey.

Menu Description
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Configuring presence profile
Do you want to manage your incoming calls taking your current presence status into 
account (see chapter "Organising absences from the desk", page 47).

You have a choice of 5 presence profiles for controlling your presence status: Available, 
Absent, Meeting, Busy, Not available. Presence profiles contain action commands that are 
executed when the presence status is activated. This may be a call forwarding to a voice 
mail and/or a predefined personal call routing.

For each of these presence profiles you can make the following settings:

Menu Description

Description Type in the text to be displayed to other users as detailed information when 
they poll your presence status (e.g. “meeting until 4 pm”). You can also leave 
this input field blank.

Time/Date Type in the time and/or date of your absence: This information is played to 
your caller, providing you selected the Absence information setting for call 
forwarding to voice mail. You can also leave this input field blank.

Personal call routing: Specify the phones on which a call is to be signalled (see chapter "Activating 
personal call routing", page 39).

• Keep settings as is • Calls are routed according to your settings.

• Call routing-ID <1...5> • Your personal call routing number.

Call forwarding: Specify where you want a call to be forwarded to (see chapter "Call forward-
ing", page 49).

• Keep settings as is • Calls are routed according to your settings.

• Forwarding off • Any configured call forwarding operation is deleted.

• User • A call is channelled to the defined forwarding destination.

• Voice mail • A call is forwarded to voice mail. The greeting to be played can be config-
ured with voice mail greeting.

Voice Mail greeting: Activate the greeting you want.

• Keep settings as is • Your currently defined greeting is used.

• Absence information • Your caller is given an absence information (as well as time and date, if this 
has been configured as such in the presence profile). This setting is not 
available in the Available presence profile. More information can be found 
in the chapter "Absence information", page 48.

• Standard greeting • The global greeting is played back to your caller.

• Personal greeting • If you renamed your personal greeting, your greeting name is displayed 
here. Your caller obtains one of the personal greetings.

• The time and date are never played in the global greeting and personal 
greetings.
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Operation of the presence settings is available via the system menu, a function key (see 
chapter "Configuring keys", page 69), or the Aastra Self Service Portal (see chapter 
"Aastra Self Service Portal", page 7).

Configuring keys
This section explains how to assign call numbers, functions, and busy lamp fields 
to a key.

Available keys

You can assign the configurable keys of your phone with a specific action type so you 
can trigger a particular action by simply pressing that key. The following choice is availa-
ble:

Menu
Press the function key for Menu.

Presence
Scroll to Presence and press the Enter softkey.

Modify Changing the presence profile:
1. Select the presence profile you want and press the Enter softkey.
2. Press the Modify > Enter softkey.
3. Select the setting you want and press the Enter softkey.
4. Make the changes and confirm with the Enter softkey.

Action type Designation Description

Call number Number key Configure a key with a call number and name.

Function Function key Configure a key with a function in order to run or activate/deacti-
vate a function.

Busy lamp field1) Team key Configure a key with your team partner's call numbers.

KT line Line key

A line key has a call number which can be used for internal or 
external calls. In general, multiple phones can be connected to this 
line. Your phone becomes a key telephone as soon as your system 
administrator has assigned the first KT line to a configurable key. 
You can make the personal settings for the KT line in the Aastra Self 
Service Portal.
KT lines are only possible on function keys T1 to T20 (Aastra 6867i) 
or T1 to T40 (Aastra 6869i). For more information on KT line keys, 
refer to chapter "Line key on a key telephone", page 54.
Note:
Your phone can be either a key telephone or an operator phone.
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Personalizing your phone 
Configuring or deleting a key assignment

You want to configure a configurable key with a call number, function or busy lamp 
field, or to delete the key configuration.

The key configuration must have been made either by your system administrator or by 
yourself in the Aastra Self Service Portal (see chapter "Aastra Self Service Portal", page 7). 
An overview of the available functions can be found in the chapter "Overview of availa-
ble functions", page 44.

Operating a key with key configuration

A key with a key configuration can be operated as follows:

Operator Operator phone

An operator phone has a line key with a call number on which both 
external and internal incoming calls can be connected. Your 
phone becomes an operator phone as soon as your system admin-
istrator has assigned the first line key on your phone. You can make 
the personal settings for the operator phone in the Aastra Self Ser-
vice Portal.
Lines for operator phones are only possible on function keys T1 to 
T20 (Aastra 6867i) or T1 to T40 (Aastra 6869i). For more informa-
tion on KT line keys, refer to chapter "Line key on a key telephone", 
page 54.
Note:
Your phone can be either a key telephone or an operator phone.

Personal line Personal call key

Personal line on key telephones and operator phones on which 
you can make personal calls. The personal line is created automat-
ically as soon as your system administrator has assigned a key on 
your phone as a KT line or operator.

1) Aastra 6865i only

<Call number> Calling the call number of a number key:
Press the key for <Call number>.
➔ The contact for this call number is called.

<Function> Activating/deactivating the function:
Press the function key for <Function>.
➔ The function is activated/deactivated. The LED on the function key is 

switched on/off (Aastra 6865i only).

<Busy lamp field> Calling the call number of a busy lamp field key:
Press the function key for <Busy lamp field>.
➔ The call number of the busy lamp field key is called.

Action type Designation Description
70 Aastra 6863i / Aastra 6865i
eud-1629/1.1 – R3.2 – 10.2014



Product and safety information
The product and document information is available here. You will also find notes 
on safety, data protection and legal notes. Please read through this product and 
safety information carefully.

Safety information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  72
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Data protection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74

Limited Warranty (Australia only). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74
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Product and safety information 
Safety information
The safety information can be found in the chapter "Safety information", page 3.

Product information

Purpose and function

This product is part of the Aastra 400 communication solution.

The software can only be launched if a communication server, configured accordingly, 
is detected.

Aastra 400 is an open, modular and comprehensive communication solution for the 
business sector with several communication servers of different output and expan-
sion capacity, a comprehensive telephone portfolio and a multitude of expansions. 
They include an application server for Unified Communications and multimedia ser-
vices, an FMC (Fixed Mobile Conversion) controller for integrating mobile phones, an 
open interface for application developers and a multitude of expansion cards and 
modules.

The business communication solution with all its components was developed to 
cover in full the communication requirements of businesses and organisations, in a 
way that is both easy to use and maintenance-friendly. The individual products and 
components are coordinated and must not be used for other purposes or replaced by 
third-party products or components (unless it is to connect other approved networks, 
applications and telephones to the interfaces certified specially for that purpose).

User information

Your product is supplied with a Quick User’s Guide, safety information and, where 
applicable, with other product-specific information.

Document portal: www.aastra.com/docfinder

© The information, graphics and layouts featured in the user information are subject to copyright and may 
not be duplicated, presented or processed without the written consent of Aastra Telecom Schweiz AG.
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 Product and safety information
These and all other user documents are available for download from the  Aastra 
DocFinder (www.aastra.com/docfinder) as individual documents or as documentation 
set. It is your responsibility to keep up to date with the scope of functions, the proper 
use and the operation of your product.

• Make sure you have all the user documents required to operate your product effi-
ciently and correctly.

• Make sure that the versions of the user documents comply with the software level 
of the Aastra 400 products used and that you have the latest editions.

• Always read the user documents first before you put your product into operation.
• Store the user information within easy reach and refer to it whenever uncertainties 

arise in connection with the use of the product.
• When handing over your product to others, make sure you enclose the relevant 

user information.

Trademarks

Aastra® is a registered trademark of Aastra Technologies Limited.

All other trademarks, product names and logos are trademarks or registered trade-
marks of their respective proprietors.

The designations used in this manual for software and hardware are registered trade-
marks and are thus subject to the relevant regulations.

Exclusion of liability

This exclusion of liability is not valid for Australia. For more information about exclu-
sion of liability in Australia refer to chapter "Limited Warranty (Australia only)", 
page 74.

All parts and components of the Aastra 400 communication solution are manufac-
tured in accordance with ISO 9001 quality guidelines.

The relevant user information has been compiled with the utmost care. The functions 
of the Aastra 400 products have been tested and approved after comprehensive con-
formity tests. Nonetheless, errors cannot be entirely excluded. The manufacturers 
shall not be liable for any direct or indirect damage that may be caused by incorrect 
handling, improper use, or any other faulty behaviour. Potential hazards are men-
tioned in the relevant places in the user information. Liability for loss of profit shall be 
excluded in any case.
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Product and safety information 
About Aastra

Aastra Technologies Limited, A Mitel Company (Nasdaq: MITL) (TSX: MNW) is a lead-
ing company at the forefront of the corporate communications market. Aastra has its 
headquarters in Concord, Ontario, Canada. Aastra develops and distributes innovative 
business communication solutions for companies of all sizes. Aastra's operations are 
truly global with more than 50 million installed lines around the world and a direct 
and indirect presence in more than 100 countries. In addition to multi-functional call 
managers, the large portfolio also offers all other elements for complete unified com-
munications applications in small, medium and large businesses. The portfolio is 
rounded off by integrated mobility solutions, call centre solutions and a large selec-
tion of phones. With its sharp focus on open standards and customized solutions 
Aastra enables companies to achieve more efficient communications and co-opera-
tion.

For additional information on Aastra, visit our website: www.aastra.com.

Data protection

Protection against listening in and recording

The Aastra 400 communication solution comprises features which allow calls to be 
monitored and recorded without the call parties noticing. Please note that these fea-
tures can only be used in compliance with national data protection provisions.

Limited Warranty (Australia only)
The benefits under the Aastra Limited Warranty below are in addition to other rights 
and remedies to which you may be entitled under a law in relation to the products.

In addition to all rights and remedies to which you may be entitled under the Compe-
tition and Consumer Act 2010 (Commonwealth) and any other relevant legislation, 
Aastra warrants this product against defects and malfunctions in accordance with 
Aastra's authorized, written functional specification relating to such products during a 
one (1) year period from the date of original purchase ("Warranty Period"). If there is a 
defect or malfunction, Aastra shall, at its option, and as the exclusive remedy under 
this limited warranty, either repair or replace the product at no charge, if returned 
within the warranty period.
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Repair Notice

To the extent that the product contains user-generated data, you should be aware 
that repair of the goods may result in loss of the data. Goods presented for repair may 
be replaced by refurbished goods of the same type rather than being repaired. Refur-
bished parts may be used to repair the goods. If it is necessary to replace the product 
under this limited warranty, it may be replaced with a refurbished product of the same 
design and colour.

If it should become necessary to repair or replace a defective or malfunctioning prod-
uct under this warranty, the provisions of this warranty shall apply to the repaired or 
replaced product until the expiration of ninety (90) days from the date of pick up, or 
the date of shipment to you, of the repaired or replacement product, or until the end 
of the original warranty period, whichever is later. Proof of the original purchase date 
is to be provided with all products returned for warranty repairs.

Exclusions

Aastra does not warrant its products to be compatible with the equipment of any par-
ticular telephone company. This warranty does not extend to damage to products 
resulting from improper installation or operation, alteration, accident, neglect, abuse, 
misuse, fire or natural causes such as storms or floods, after the product is in your pos-
session. Aastra will not accept liability for any damages and/or long distance charges, 
which result from unauthorized and/or unlawful use.

To the extent permitted by law, Aastra shall not be liable for any incidental damages, 
including, but not limited to, loss, damage or expense directly or indirectly arising 
from your use of or inability to use this product, either separately or in combination 
with other equipment. This paragraph, however, is not intended to have the effect of 
excluding, restricting or modifying the application of all or any of the provisions of 
Part 5-4 of Schedule 2 to the Competition and Consumer Act 2010 (the ACL), the exer-
cise of a right conferred by such a provision or any liability of Aastra in relation to a 
failure to comply with a guarantee that applies under Division 1 of Part 3-2 of the ACL 
to a supply of goods or services.

This express warranty sets forth the entire liability and obligations of Aastra with 
respect to breach of this express warranty and is in lieu of all other express or implied 
warranties other than those conferred by a law whose application cannot be 
excluded, restricted or modified. Our goods come with guarantees that cannot be 
excluded under the Australian Consumer Law. You are entitled to a replacement or 
refund for a major failure and for compensation for any other reasonably foreseeable 
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Product and safety information 
loss or damage. You are also entitled to have the goods repaired or replaced if the 
goods fail to be of acceptable quality and the failure does not amount to a major fail-
ure.

Warranty Repair Services

Procedure: Should the product fail during the warranty period and you wish to make a 
claim under this express warranty, please contact the Aastra authorized reseller who 
sold you this product (details as per the invoice) and present proof of purchase. You 
will be responsible for shipping charges, if any.

Limitation of liability for products not of a kind ordinarily acquired for personal, 
domestic or household use or consumption (e.g. goods/services ordinarily supplied 
for business-use).

Limitation of liability

1.1 To the extent permitted by law and subject to clause 1.2 below, the liability of Aastra to you 
for any non-compliance with a statutory guarantee or loss or damage arising out of or in 
connection with the supply of goods or services (whether for tort (including negligence), 
statute, custom, law or on any other basis) is limited to:

a) in the case of services:

i) the resupply of the services; or

ii) the payment of the cost of resupply; and

b) in the case of goods:

i) the replacement of the goods or the supply of equivalent goods; or

ii) the repair of the goods; or

iii) the payment of the cost of replacing the goods or of acquiring equivalent goods; or

iv) the payment of the cost of having the goods repaired.

1.2 Clause 1.1 is not intended to have the effect of excluding, restricting or modifying:

a) the application of all or any of the provisions of Part 5-4 of Schedule 2 to the Competition 
and Consumer Act 2010 (the ACL); or

b) the exercise of a right conferred by such a provision; or

c) any liability of Aastra in relation to a failure to comply with a guarantee that applies under 
Division 1 of Part 3-2 of the ACL to a supply of goods or services.
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After Warranty Service

Aastra offers ongoing repair and support for this product. If you are not otherwise 
entitled to a remedy for a failure to comply with a guarantee that cannot be excluded 
under the Australian Consumer Law, this service provides repair or replacement of 
your Aastra product, at Aastra's option, for a fixed charge. You are responsible for all 
shipping charges. For further information and shipping instructions contact:

Manufacturer: Note:

Aastra Telecom Australia Pty Ltd ("Aastra")
Level 12, 45 William Street
Melbourne, Victoria 3000, Australia, ABN: 16 140 787 195
Phone: +61 3 8628 9500

Repairs to this product may be made only by 
the manufacturer and its authorized agents, or 
by others who are legally authorized. Unau-
thorized repair will void this express warranty.
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CE conformity

Aastra Telecom Schweiz AG hereby declares that

• the Aastra 400 products conform to the basic 
requirements and other relevant stipulations of 
Directive1999/5/EC.

• all our products are manufactured in conformity 
with RoHS according to 2011/65/EU.

The product-specific declarations of conformity 
can be found on the Aastra 400 DocFinder:
www.aastra.com/docfinder.

Exclusion of liability

Aastra® is a registered trademark of Aastra Tech-
nologies Limited. Technical modifications and 
product availability subject to change without 
notice.

Copyright © 2014 Aastra Technologies Limited

www.aastra.com/docfinder

	Aastra 6863i and Aastra 6865i: 
User’s Guide
	Document information: eud-1629/1.1 – R3.2 – 10.2014


	Content
	Welcome...
	Safety information
	Document information
	Communication system and software versions
	Document designation


	Information as to the Aastra 400 communication system
	One number user concept
	Aastra Self Service Portal

	Keys, display and menu guidance
	Key designations and sockets
	Display symbols
	Operating your phone
	Overview system menu
	Using the softkey/navigation key
	Free configurable keys
	Overview function key configuration (default key setting)
	Overview alphanumeric keyboard
	Entering text
	LED overview

	Using expansion key modules
	Expansion key module Aastra M680i
	Expansion key module Aastra M685i 

	Using labels
	Printing and attaching the labels


	Phoning
	Making calls
	Answering, ending or rejecting a call
	Using your phone in handsfree mode
	Muting the microphone

	Using a headset (Aastra 6865i only)
	Initiating calls
	Dialling with the phone number
	Dialling from the phone book (directory lookup)
	Dialling from the call list
	Dialling with a configurable key
	Dialling with the line key
	Activating another Aastra phone for making calls
	Private call with PIN

	Using functions before/while in a call
	Requesting a callback
	To answer the callback request
	Hide number
	Putting a call partner on hold
	Enquiry call during a call
	Brokering between an enquiry call party and your call partner
	Making a conference call
	Transferring a call
	Take (pick up own call)
	Starting announcement
	Receiving an announcement\
	Recording a call
	Activating do not disturb

	Using further functions
	Activating personal call routing
	Activating ring alone
	Locking/Unlocking your phone
	Acknowledging an appointment call
	Free seating
	Hotline

	Overview of available functions
	Organising absences from the desk
	Controlling the presence status
	Absence information
	Call forwarding

	Operating call lists and voice messages
	Editing options for the call list
	Editing options for voice messages

	Organisation within the team (busy lamp field, Aastra 6865i only)
	Using the busy lamp field key
	Calling a team partner
	Answering a call for a team partner

	Line key on a key telephone
	Answering a call on the KT line key
	Initiating a call via a KT line key

	Using functions with OpenCount
	Activating PIN telephony

	Setting functions by remote control

	Personalizing your phone
	Configuring the display
	Setting the display

	Configuring the audio properties
	Adjusting the volume
	Setting the ringing properties
	Setting the audio properties

	Configuring general phone settings
	Selecting the language
	Selecting the time and date
	Using Live Dialpad (single-digit dialling)
	Using speed dial edit
	Changing the PIN
	Enter the display text for the idle state
	Local IP settings
	Restarting the phone

	Protecting yourself against calls
	Activating protection against call types

	Phone books management
	Selection

	Configuring voice mail
	Managing personal voice mail greeting

	Configuring presence profile
	Configuring keys
	Available keys
	Configuring or deleting a key assignment
	Operating a key with key configuration


	Product and safety information
	Safety information
	Product information
	Purpose and function
	User information
	Trademarks
	Exclusion of liability
	About Aastra

	Data protection
	Protection against listening in and recording

	Limited Warranty (Australia only)
	Repair Notice
	Exclusions
	Warranty Repair Services
	After Warranty Service



	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V


